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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3700A Vector Signal Generator 
Operation Manual (Mainframe), MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe), MS2690A/MS2691A/ 
MS2692A Signal Analyzer Operation Manual 
(Mainframe Operation), MS2830A Signal Analyzer 
Operation Manual (Mainframe Operation), or 
MS2840A Signal Analyzer Operation Manual 
(Mainframe Operation). Please also refer to either of 
these documents before using the equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information.  Ensure that you clearly understand the meanings 
of the symbols BEFORE using the equipment.  Some or all of the following symbols may be used on all Anritsu 
equipment.  In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 

This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions.  Ensure that you clearly understand the meanings of the symbols 
and take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation.  The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution.  The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution.  The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note.  The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 

 

MX370102A/MX269902A 
TDMA IQproducerTM  
Operation Manual 
 
1 November 2004 (First Edition) 
19 July 2017 (15th Edition) 
 
Copyright © 2004-2017, ANRITSU CORPORATION. 
All rights reserved.  No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 

 DANGER 

 WARNING 

 CAUTION 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for injury or financial loss of the 
customer due to the use of or a failure to be able to use this equipment. 
 
 

Anritsu Corporation Contact 
In the event of this equipment malfunctions, contact an Anritsu Service and 
Sales office. Contact information can be found on the last page of the printed 
version of this manual, and is available in a separate file on the PDF version. 
 



 

iv 

 

 
 

Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 
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Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, 
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this 
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter 
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment 
(hereafter Equipment) for the purposes set out in this EULA. 
 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Cautions against computer virus infection 
• Copying files and data 
 Only files that have been provided directly from Anritsu or generated 

using Anritsu equipment should be copied to the instrument. 
 All other required files should be transferred by means of USB or 

CompactFlash media after undergoing a thorough virus check. 
• Adding software 
 Do not download or install software that has not been specifically 

recommended or licensed by Anritsu.  
• Network connections 
 Ensure that the network has sufficient anti-virus security protection in 

place. 
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Protection Against Computer Virus Infections 

Prior to the software installation 
Before installing this software or any other software recommended or 
approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB memory stick and CF memory card) you 
want to connect to your computer. 
 
When using this software and connecting with the measuring instrument 
• Copying files and data 

On your computer, do not save any copies other than the following: 
 • Files and data provided by Anritsu 
 • Files created by this software 
 • Files specified in this document 

Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB memory stick and CF memory card). 

• Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

 
 
 

Cautions on Proper Operation of Software 

This software may not operate normally if any of the following operations 
are performed on your computer: 
• Simultaneously running any software other than that recommended or 

approved by Anritsu 
• Closing the lid (Laptop computer) 
• Turning on the screen saver function 
• Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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CE Conformity Marking 
Anritsu affixes the CE conformity marking on the following product(s) in 
accordance with the Council Directive 93/68/EEC to indicate that they 
conform to the EMC and LVD directive of the European Union (EU). 
 

CE marking 

 

1. Product Model 
Software: MX370102A/MX269902A TDMA IQproducerTM 

 
2. Applied Directive and Standards 
 When the MX370102A/MX269902A TDMA IQproducerTM is installed in 

the MG3710A/MG3740A, MS2690A/MS2691A/MS2692A, MS2830A, or 
MS2840A, the applied directive and standards of this software conform to 
those of the MG3710A/MG3740A, MS2690A/MS2691A/MS2692A, 
MS2830A, or MS2840A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370102A/MX269902A can be used with. 
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RCM Conformity Marking 
Anritsu affixes the RCM mark on the following product(s) in accordance with 

the regulation to indicate that they conform to the EMC framework of 

Australia/New Zealand. 

 
RCM marking 

 

 
1. Product Model 

Software: MX370102A/MX269902A TDMA IQproducerTM 

 
2. Applied Directive and Standards 
 When the MX370102A/MX269902A TDMA IQproducerTM is installed in 

the MG3710A/MG3740A, MS2690A/MS2691A/MS2692A, MS2830A, or 

MS2840A, the applied directive and standards of this software conform to 

those of the MG3710A/MG3740A, MS2690A/MS2691A/MS2692A, 

MS2830A, or MS2840A main frame. 

 
 PS: About main frame 

 Please contact Anritsu for the latest information on the main frame 

types that MX370102A/MX269902A can be used with. 
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About This Manual 
■ Associated Documents 
The operation manual configuration of the MX370102A/MX269902A 
TDMA IQproducerTM is shown below.  

■ If using MG3700A, MG3710A or MG3740A:  

Or 

 

MX370102A/MX269902A  
TDMA IQproducer™ Operation Manual  

MG3700A /MG3710A Vector Signal Generator 
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 

MG3700A  
Vector Signal Generator  
Operation Manual (Mainframe) 

MG3710A Vector Signal Generator  
MG3740A Analog Signal Generator  
Operation Manual (Mainframe) 

 

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3700A Vector Signal Generator.  

 Or 

 MG3710A Vector Signal Generator MG3740A Analog Signal Generator 

Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A Vector Signal Generator and the MG3740A 
Analog Signal Generator. 
 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator. 

 

 TDMA IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the TDMA IQproducerTM.  
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■ If using MS2690A/MS2691A/MS2692A, MS2830A or 
MS2840A:  

MX370102A/MX269902A  
TDMA IQproducer™ Operation Manual 

 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Option 020:  
Vector Signal Generator  
Operation Manual  
(Operation) 

MS2830A/MS2840A 
Signal Analyzer 
Vector Signal Generator 
Operation Manual  
(Operation) 

Or 

MS2690A/MS2691A/MS2692A 
Signal Analyzer Option 020: 
Vector Signal Generator 
Operation Manual 
(Remote Control) 

MS2830A/MS2840A 
Signal Analyzer Vector Signal 
Generator Operation Manual  
(Remote Control) 

Or 

MS2690A/MS2691A/MS2692A and MS2830A/MS2840A 
Vector Signal Generator Operation Manual (IQproducer™) 

MS2690A/MS2691A/MS2692A Signal Analyzer Operation Manual  
(Main Frame Operation)

MS2690A/MS2691A/MS2692A and MS2830A/MS2840A/MS2850A 
Signal Analyzer Operation Manual (Main Frame Remote Control) 

MS2840A Signal Analyzer Operation Manual  
(Main Frame Operation) 

Or 
MS2830A Signal Analyzer Operation Manual  
(Main Frame Operation)
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 Signal Analyzer Operation Manual (Mainframe, Operation) 

This describes basic operations, maintenance procedure, common func-
tions.  
---------------------------------------------------------------------------------------------- 

 Signal Analyzer Operation Manual (Mainframe, Remote Control) 

These describe common remote functions.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 

Or 

 MS2830A/MS2840A Vector Signal Generator Operation Manual, Opera-

tion 

This describes the functions and how to use the Vector Signal Generator 
option. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion.  

Or 

 MS2830A/MS2840A Vector Signal Generator Operation Manual, Remote 

Control 

This describes how to remotely control the Vector Signal Generator op-
tion. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Vector Signal 

Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator option. 
---------------------------------------------------------------------------------------------- 

 TDMA IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the TDMA IQproducer™.  
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This chapter provides an overview of the MX370102A/MX269902A TDMA 
IQproducer. 

 

1.1 Product overview .......................................................... 1-2 
1.2 Product Composition .................................................... 1-3 
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1.1 Product overview 
MX370102A/MX269902A TDMA IQproducer (hereinafter referred to as 
“this software”) is software used to generate waveform patterns 
conforming to the TDMA specifications.  

 
This software requires either of the following environment: 

• MG3710A Vector Signal Generator 
• MG3740A Analog Signal Generator 
• MS2690A/MS2691A/MS2692A, MS2830A or MS2840A Signal 

Analyzer with Vector Signal Generator option mounted 
• Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of TDMA with various characteristics. This is made 
possible by the editing/customizing of parameters according to its use.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3700A Vector Signal 
Generator , MG3710A Vector Signal Generator, MG3740A Analog Signal 
Generator or an MS2690A/MS2691A/MS2692A, MS2830A or MS2840A 
Signal Analyzer with Vector Signal Generator option installed 
(collectively referred to as “mainframe”, or “this equipment”). 
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1.2 Product Composition 
The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2-1  Restrictions 

Mainframe 

 

Restrictions 

MG3700A MG3710A 
MG3740A 

MS2690A 
MS2691A 
MS2692A 

MS2830A MS2840A 

Software name MX370102A MX269902A 

Maximum Size 
of Waveform 
Patterns 

256 M sample 
512 M sample*1 

64 M sample 
128 M sample*5 
256 M sample*6 
512 M sample*7 

256 M sample 64 M sample 
256 M sample*4 

64 M sample 
256 M sample*4 

Transmission 
method of 
Waveform 
Patterns 

LAN, 
CompactFlash 
Card 

External device 
such as LAN, 
USB memory*2 

USB Memory 
and other 
external 
device*2 

USB memory 
stick and other 
external 
device*2 

USB memory 
stick and other 
external 
device*2 

Installation of 
this software 
to this 
equipment 

N/A Possible  Possible*3 Possible*3 Possible*3 

*1: The ARB memory expansion 512 M sample (optional) must be 
installed into the MG3700A to use waveform patterns that exceed 
256 M samples. 

*2: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*3: Although this software can be installed and run in the 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A, the 
measurement functions of the MS2690A/MS2691A/MS2692A, 
MS2830A or MS2840A are not guaranteed while this software runs. 

*4: The ARB memory expansion 256 M sample (optional) must be 
installed into the Vector Signal Generator option to use waveform 
patterns that exceed 64 M samples.  

*5: The Combination of Baseband Signal (optional) must be installed 
into the MG3710A/MG3740A to use waveform patterns of maximum 
128 M samples. 

*6: The ARB memory expansion 256M sample (optional) must be 
installed into the MG3710A/MG3740A to use waveform patterns of 
maximum 256 M samples.  
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*7: To use waveform patterns of maximum 512 M samples, either of the 
following must be installed: 
MG3710A 
• ARB memory expansion 1024 M sample (optional) 

• ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 

MG3740A 
• ARB memory expansion 256 M (optional) and Combination of 

Baseband Signal (optional) 
 

■ Notes on waveform pattern conversion 
The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, refer to each one of 
the following manuals.  

• MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen” 

• MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Vector Signal 
Generator Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen”  
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This chapter describes the operating environment for the 
MX370102A/MX269902A. 

 

2.1 Operating Environment ................................................. 2-2 
2.2 Installation/Uninstallation .............................................. 2-3 
2.3 Starting up and exiting the software ............................. 2-4 

2.3.1 Starting Software: When installed  

on other than MG3710A ................................... 2-4 
2.3.2 Starting Software: When installed  

on MG3710A .................................................... 2-6 
2.3.3 Exiting Software ................................................ 2-7 
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2.1 Operating Environment 
The following environment is required for operating this software. 

(1) PC that meets the following conditions 

OS Windows XP/Windows Vista/Windows 7 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 Msample) waveform patterns. 

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

■ Installing/Uninstalling IQproducer™ 

For how to install and uninstall IQproducer™, refer to each of the 
following manuals:  

 MG3700A/ MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Vector Signal 
Generator Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 

■ Installing/Uninstalling IQproducer™ license file 

For how to install license file to MG3700A/MG3710A/MG3740A, refer to 
the following manual:  

 MG3700A/ MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3700A/MG3710A/MG3740A, 
refer to each one of the following manuals:  

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.10.10 “Install” 

 MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
9.4.4 “Install” 

 
Refer to the following manual for details of how to install/uninstall 
license file to MS2690A/MS2691A/MS2692A, MS2830A or MS2840A with 
Vector Signal Generator option.  

 MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Vector Signal 
Generator Operation Manual (IQproducer™) 
2.2 “Installation/Uninstallation” 
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2.3 Starting up and exiting the software 
This section explains how to start and stop this software. 

Note: 

The following explanation assumes the use of Windows XP. The 
screen image may differ slightly if not using Windows XP. 

 

2.3.1 Starting Software: When installed on other than MG3710A 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  

<Procedure> 

1. Click Start on the task bar, and point to All Programs. Next, point to 
Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 

On the Select instrument screen, select the model of the main unit 
that uses the waveform patterns created by IQproducer™.  

 

Notes: 

 The software does not support MG3740A. 

 To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 
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3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

 

Figure 2.3.1-1  Common Platform Screen 

 

4. Click the General Purpose tab on the common platform screen, to 
show the General Purpose selection screen that supports each 
telecommunication system.  

 
 

 

Figure 2.3.1-2  General Purpose Selection Tab 

 

5. Click TDMA to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 

If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A 
Start this software using the following procedure.  

<Procedure> 

1. Press  on the MG3710A/MG3740A front panel to display the 
common platform screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.2-1  Common Platform Screen 

 

2. Click the General Purpose tab on the common platform screen, 
to show the General Purpose selection screen that supports 
each telecommunication system.  

 

Figure 2.3.2-2  General Purpose Selection Tab 
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3. Click TDMA to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 

When this software is installed on MG3710A/MG3740A, Change 
Instrument displays instead of Interface Settings. Clicking 
Interface Settings displays the Interface Setting dialog box.  

 

Figure 2.3.2-3  Interface Settings Dialog Box 

 

Here, you can configure interface-related settings of IQproducer 
and MG3710A/MG3740A. To return to factory defaults, click 
Default.  

 Row Socket Port Number 

Sets Row Socket port number. Set the same value as that for 
MG3710A/MG3740A.  

 Wait Time 

Sets the wait time between commands.  

2.3.3 Exiting Software 
Stop this software using the following procedure. 
■ When exiting only this software 

To exit only this software without closing the Common Platform screen, 
or other IQproducer™ tools, do one of these below: 

 Click the Exit button ( ) on the tool bar. 

 Select Exit from the File menu. 

 Click the  button on the upper right screen. 

 

Figure 2.3.3-1  Exiting Software 
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The operation of the three screen buttons is explained below.  

 

 

Figure 2.3.3-2  Exit Confirmation Window 

 

 Yes Saves current parameters to file and stops this 
software. 

 No Stops this software without saving current 
parameters to file. 

 Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  

■ When exiting entire IQproducer™ application 

To exit all tools of IQproducer™ that are running, select Exit on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  

  

Figure 2.3.3-3  Exiting IQproducer™ 
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This chapter provides detailed descriptions of this software.  

Notes: 
• The examples and screens used throughout this chapter are 

based on the assumption that the IQproducer™ is activated 
with the MG3700A.  

• The MG3710A, MG3740A, MS2690A/MS2691A/MS2692A, 
MS2830A and MS2840A functions are described as notes in 
each item.  

 

3.1 Screen Layout and Composition................................... 3-2 
3.1.1 Main screen ...................................................... 3-2 
3.1.2 Parameter setting sheet ................................. 3-11 
3.1.3 Calculation ...................................................... 3-42 
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3.1.8 Auxiliary signal output..................................... 3-57 

3.2 Waveform Pattern Generation Procedure .................. 3-58 
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3.1 Screen Layout and Composition 
3.1.1 Main screen 

On common platform screen, click the General Purpose tab, and then 
click TDMA to display the main screen.  

  

Figure 3.1.1-1  TDMA IQproducer Main Screen (When on MG3710 or MG3740) 
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Figure 3.1.1-2  TDMA IQproducer Main Screen (When on PC) 

 
■ File menu 

The File menu contains the following items. 

 

Figure 3.1.1-3  File menu 
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• Select Option 
Notes: 

• This function is available only when MG3700, MG3710, 
MG3740, MS2830 or MS2840 is selected in the Select 
instrument screen. 

• ARB Memory Expansion (option) is not available for 
MS269xA. Only Memory 256M samples, 1 GB is available.  

■ When using MG3700A, MS2830A or MS2840A 

 Select whether the ARB memory expansion option 256Msamples is 
installed. Selecting With Option21 (Memory 512M samples)/With 
Option27 (Memory 256M samples) supports creation of larger 
waveform patterns. If the ARB memory expansion option is not 
installed, the generated waveform pattern may not be able to be 
used. Waveform patterns cannot be created with a size greater than 
256Msamples or 64M samples when Without Option21 (Memory 
512M samples)/Without Option27 (Memory 256M samples) is 
selected. Select either according to the presence of ARB memory 
expansion option. 

Table 3.1.1-1  Available Options for MG3700A, MS2830A or MS2840A 

Model Items ARB Memory 
Expansion 

MG3700A 
With Option21 (Memory 512M samples) 1 GB x 2 memories 
Without Option21 (Memory 512M samples) 512 MB × 2 memories 

MS2830A With Option27 (Memory 256M samples) 1 GB 
Without Option27 (Memory 256M samples) 256 MB 

MS2840A 
With Option27 (Memory 256M samples) 1 GB 
Without Option27 (Memory 256M samples) 256 MB 

 
■ When using MG3710A or MG3740A 

 The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

 Set the combination of installed options based on the following 
setting items.  
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Table 3.1.1-2  Available Options for MG3710A or MG3740A 

Items Combinations of Options 
Memory 64M samples None 
Memory 64M samples × 2 Option48 and Option 78 
Memory 256M samples Option45 or Option 78 

Memory 256M samples × 2 
Option 45 and Option 48 
or 
Option 75 and Option 78 

Memory 1024M samples* Option46 or Option 76 

Memory 1024M samples × 2* 
Option 46 and Option 48 
or 
Option 76 and Option 78 

*: Option 46 and Option 76 are not available for MG3740A and do not 
appear on the display. 

 
The maximum size of the generated waveform pattern for each of 
the setting items is shown below.  

Table 3.1.1-3  Waveform Pattern Maximum Size 

Items Maximum Size 
Memory 64M samples 64M samples 
Memory 64M samples × 2 
(With Option48, 78) 128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 
(With Option48, 78) 512M samples 

Memory 1024M samples* 512M samples 
Memory 1024M samples × 2* 
(With Option48, 78) 512M samples 

*: Does not support MG3740A. 
 

• Recall Parameter File 
Loads the parameter files saved by Save Parameter File. Setting 
can be facilitated by using the loaded parameters. 
 

• Save Parameter File 
Saves the setting parameters to a file. 
 

• Exit 
Exits this Software. 
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■ Edit menu 
The Edit menu contains the following item. 

 

Figure 3.1.1-4  Edit menu 
 

• Calculation Waveform Pattern 
Starts waveform pattern generation after parameter setting. This is 
the same operation with clicking the Calculation button on a 
parameter setting sheet. 

 
• Calculation & Load  

Note: 
This function is available only when this software is used on 
MG3710A or MG3740A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A or MG3740A waveform 
memory.  

 
• Calculation & Play  

Note: 
This function is available only when this software is used on 
MG3710A or MG3740A. 

After waveform generation is finished, the created waveform 
pattern is loaded and selected at the MG3710A or MG3740A 
waveform memory.  

 
• Clipping 

Displays the Clipping setting screen. In this screen, clipping and 
filtering processing can be performed for a generated waveform 
pattern.  
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■ Transfer Setting Menu 
The Transfer Setting menu contains the following item. 

 

Figure 3.1.1-5  Transfer Setting menu 
 

• Transfer & Setting Wizard  
Note: 

This function is available only when MG3700, MG3710 or 
MG3740 is selected in the Select instrument screen.  

Displays the Transfer Setting Wizard screen. Every operation 
ranging from connecting the PC and MG3700A, MG3710A or 
MG3740A and transferring the waveform pattern to the MG3700A, 
MG3710A or MG3740A, to loading the waveform pattern into the 
MG3700A, MG3710A or MG3740A ARB memory is performed at 
this screen. 

 
■ Simulation menu 

The Simulation menu contains the following items. 

 

Figure 3.1.1-6  Simulation menu 
 

• CCDF 
Displays the CCDF graph display screen. In this screen, the CCDF 
of the generated waveform pattern is displayed in a graph. 
 

• FFT 
Displays the FFT graph display screen. In this screen, the 
FFT-processed spectrum of the generated waveform pattern is 
displayed in a graph. 
 

• Time Domain 
Displays the Time Domain screen. In this screen, the time domain 
waveform of a generated waveform pattern is displayed in a graph.  
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 Tool buttons 
The following tool buttons are provided: 

Notes: 
• Transfer&Setting Wizard is available only when MG3700, 

MG3710 or MG3740 is selected in the Select instrument screen.  

• Calculation & Load and Calculation & Play are available only 
when this software is used on MG3710A or MG3740A. 

 Recall Parameter File 

 Save Parameter File 

 Calculation 

 Calculation & Load 

 Calculation & Play 

 Transfer & Setting Wizard 

 CCDF 

 FFT 

 Time Domain 

 Clipping 

 Exit 

 

Clicking a tool button operates the same as the corresponding 
commands in the menu.  
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 Parameter setting sheets 
 

 

Figure 3.1.1-7  Parameter setting sheets 
 

 The parameter setting sheets are provided on the left of the TDMA 
main screen, consisting of three independent sheets: Burst, 
Continuous, and No Format. Each parameter setting sheet has setting 
item buttons. When one of these setting item buttons is clicked, the 
corresponding setting screen is displayed. Although the setting item 
buttons are placed sequentially from top down with arrows, it is not 
necessary to perform parameter settings in this order. Note, however, 
that some parameters have an effect on the subsequent parameters. 
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 Parameter File display 
 

 

Figure 3.1.1-8  Parameter File display 
 

 When reading or saving a parameter file, the target file name is 
displayed in this area. 
 

 Waveform Information display 
 

 

Figure 3.1.1-9  Waveform Information display 
 

 The settings of the current parameter are displayed for each 
parameter setting sheet. 
 

 Initialization button 
 

 

Figure 3.1.1-10  Initialization button 
 

 Clicking this button initializes the parameters on the selected 
parameter setting sheet. 
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3.1.2 Parameter setting sheet 
There are three parameter setting sheets (Burst, Continuous, No 
Format) on the TDMA main screen, and each sheet is displayed by 
clicking the tab on the sheet. Each parameter setting sheet has five or 
seven setting item buttons, and when one of these buttons is clicked, the 
corresponding setting screen is displayed. Although the setting item 
buttons are placed sequentially from top down with arrows, it is not 
necessary to perform parameter settings in this order. Note, however, 
that some parameters have an effect on the subsequent parameters (refer 
to Section 3.1.2.8 “Re-setting by changing parameter”). 

The following setting item buttons are provided: 
[Modulation], [Frame], [Slot], [Field], [Data], [Filter], [Pattern Name], 
[Calculation] 

The setting item buttons are different among parameter setting sheets. 
See the table below for what setting item buttons are provided in each 
parameter setting sheet. 

Table 3.1.2-1  Setting item buttons provided on each parameter  
setting sheet 

Setting Item Buttons 
Parameter Setting Sheets 

Burst Continuous No Format 
Modulation    

Frame   − 
Slot   − 
Field   − 
Data − −  
Filter    

Pattern Name    
Calculation    

 
• Burst: Used to generate a burst waveform with a slot format. 
• Continuous: Used to generate a continuous waveform with a slot 

format. 
• No Format: Used to generate a continuous waveform without a slot 

format. 
 

When running on MG3710A or MG3740A the Calculation & Load, 
Calculation & Play buttons display instead of the Calculation button.  

The following sections show the setting screens corresponding to each 
setting item. 
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3.1.2.1 Modulation 
In the “Modulation” setting item, the modulation type, symbol rate, and 
oversampling rate can be set. The 2nd modulation type can be set only in 
the Burst parameter setting sheet, and the modulation type can be 
switched within one slot. Clicking the [Modulation] button on a 
parameter setting sheet displays the Modulation setting screen. 

After setting the parameters, click the [OK] button on the screen to apply 
the current settings and close the Modulation setting screen. Clicking the 
[Cancel] button or  button on the upper right of the screen closes the 
Modulation setting screen canceling the current settings. 

 

Figure 3.1.2.1-1  Modulation setting screen (When running on PC, 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A) 

 

 

Figure 3.1.2.1-2  Modulation setting screen (When running on 
MG3710A or MG3740A) 

 



 

3.1 Screen Layout and Composition 

3-13 

3 

D
etailed D

escription of Functions 

The following parameters can be set in the Modulation setting screen. 

Modulation Type (1st Modulation Type) 
[Overview] Set the 1st modulation type. 
[Default] PI/4DQPSK 
[Options] BPSK, DBPSK, PI/2DBPSK, 

QPSK, O-QPSK, DQPSK, PI/4DQPSK,  
8PSK, D8PSK, 
16QAM, 32QAM, 64QAM, 256QAM,  
2ASK, 4ASK, 2FSK, 4FSK, User defined 

[Remarks] Symbol points on the IQ plane for each modulation 
type are shown in the Modulation Type list box, and 
the decimal numbers corresponding to each symbol 
point are listed in the table in the lower part of the 
screen. (Similar figures and tables are provided in 
Appendix B for reference.) 
For modulation types 8PSK, D8PSK, 16QAM, 32QAM, 
64QAM, and 256QAM, 4FSK, the decimal numbers 
corresponding to each symbol point can be changed by 
clicking the referential button  under the IQ 
plane and selecting a user file for IQ mapping.  Refer 
to Appendix C “User File Format” for details on the 
user file.  
For modulation types BPSK and QPSK, the symbol 
points can be rotated by 45° by selecting the check box 

 under the Modulation Type list 
box. 
When generating Continuous or No Format waveform 
at 2FSK and 4FSK, the phase may not be continuous 
between the first and last waveform data.  
User defined can be selected only when the parameter 
setting sheet is No Format.  
When User defined is selected, Modulation Mapper is 
displayed and a user file in which the modulation type 
is defined can be specified.  
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Modulation Mapper 
When User defined is selected at Modulation Type, Modulation Mapper 
is dispalyed below the Modulation Type list box.  

 

Figure 3.1.2.1-3  Modulation setting screen  
(When Modulation Type is User defined) 

 

[Overview] This displays the user file for the currently selected 
user defined modulation. And a user file in which the 
modulation type is defined can be specified.  
Using this function creates the waveforms of the APSK 
format, such as 16APSK, and the multiple-valued 
QAM format that is more than 512QAM. Refer to 
Appendix C “User File Format” for details of the user 
file for user defined modulation.  
When the referential button on the right side of 
Modulation Mapper ( ) is clicked, a new user 
file for user defined modulation can be selected in the 
user file selection dialog box.  
When User defined is selected while a user file for user 
defined modulation has not been selected, the user file 
selection dialog box is automatically displayed.  
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Modulation Type (2nd Modulation Type) 
[Overview] Set the 2nd modulation type. 
[Default] PI/4DQPSK 
[Options] BPSK, DBPSK, PI/2DBPSK, 

QPSK, DQPSK, PI/4DQPSK, 8PSK, D8PSK, 
16QAM, 32QAM, 64QAM, 256QAM 

[Remarks] The settings for the 2nd modulation type can be 
configured by selecting the check box 

. Note, however, that the 2nd 
modulation type cannot be set when 2ASK, 4ASK, 
2FSK, or 4FSK is set for the 1st modulation type. 
The decimal numbers corresponding to each symbol 
point are displayed in the same manner as for the 1st 
modulation type. 
 

Symbol Rate, Modulation Index, Maximum Frequency deviation 
The display changes according to the setting made for modulation type.  

Other than below: Symbol Rate 
2ASK, 4ASK, 2FSK: Modulation Index 
4FSK: Maximum Frequency deviation 
 

Symbol Rate 
[Overview] Set the symbol rate. 
[Default] 1 Msps 
[Setting range] 1 ksps to 80 Msps Except for MG3740A 
 1 ksps to 4 Msps MG3740A 
[Resolution] 1 sps 
 
Over Sampling 
[Overview] Set the oversampling rate. 
[Default] 2 
[Options] 2, 3, 4, 8, 16, 32 
[Remarks] The setting range varies depending on the modulation 

index when 2FSK is set for the modulation type. 
 
Sampling Rate 
[Overview] Set the sampling rate. 
[Default] 2 MHz 
[Setting range] 20 kHz to 160 MHz Except for MG3740A 
 20 kHz to 8 MHz MG3740A 
[Remarks] The value of symbol rate × oversampling rate is 

automatically set. When the Manchester code setting 
is enabled, however, the value of symbol rate × 
oversampling rate × 2 is automatically set. 
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GSM 
[Overview] Enable/disable the automatic setting in accordance 

with GSM. 
 When 8PSK or 2FSK is set for the modulation type, 

the check box  appears under the 
Modulation Type list box. When this check box is 
selected, the automatic setting is performed in 
accordance with GSM. Note, however, that the 2nd 
modulation type cannot be set when the GSM check 
box is selected. 
The setting values are as follows. 
 
Symbol data: 8PSK symbol data 

(Refer to Appendix 
B) 

Symbol rate: 270.833 ksps 
Oversampling rate: 12 
Number of slots (see 
3.1.2.2): 

8 slots 

Ramp length (see 3.1.2.3) 2 symbols × 2 
Guard length (see 3.1.2.3) 4.25 symbols 
Filter (see 3.1.2.6) Specified Filter 

 
Modulation Index 
[Overview] Set the modulation index. 
[Default] 1 
[Setting range] 0.00 to 1.00 (for 2ASK, 4ASK), 0.20 to 10.00 (for 2FSK) 
[Remarks] The modulation index can be set in the text box that 

appears under the Modulation Type list box when 
2ASK, 4ASK or 2FSK is set for the modulation type. 
When the modulation type is 2FSK, the setting range 
of the oversampling rate varies depending on the 
modulation index. 
 

Manchester Code 
[Overview] Enable/disable Manchester code setting. 
 When 2ASK is set for the modulation type, the check 

box  appears under the 
Modulation Type list box. The Manchester code is 
selected when this check box is selected, and NRZ is 
selected when this check box is cleared. NRZ is always 
selected for modulation types other than 2ASK. 
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Maximum frequency deviation 
[Overview] This sets the maximum frequency deviation.  
[Default] 945 
[Setting range] 120 to 100000 
[Remarks] This is available only when 4FSK is selected for 

modulation; a text box appears below the Modulation 
Type list box.  

 
Mapping Edit 
Click the referential button on the right hand side of Mapping Edit. Here 
you can select user file. 
Refer to Appendix C.1 “IQ Mapping User File Format” for details.  

Keep Phase continuity 
[Overview] This function keeps the continuity of phase header and 

footer of waveform pattern. 
[Remarks] This is available when parameter setting sheet is 

Continuous, No Format, and when modulation method is 
2FSK, 4FSK. 

  
Note: 

When the Number of Frames setting is set to AUTO, the number of 
frames to be generated differs depending on whether the Keep 
phase continuity check box is selected or not.  
If selected, the number of frames is determined by the data 
frequency set for Data Field. This is because it is no longer 
necessary to repeat until the header and footer of waveform 
pattern matches, as previously.  

If the check box is selected, offset to applied to the waveform pattern 
frequency. Its value is displayed as “Frequency Offset” as shown below.  

 

Figure 3.1.2.1-4  Waveform Generation Screen 
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3.1.2.2 Frame 
In the “Frame” setting item, the number of frames, the number of slots 
per frame, and the transmission status of each slot (ON/OFF) can be set. 
This setting item is not provided in the No Format parameter setting 
sheet. Clicking the [Frame] button on the Burst or Continuous parameter 
setting sheet displays the Frame setting screen shown in Figure 
3.1.2.2-1. 

After setting the parameters, click the [OK] button on the screen to apply 
the current settings and close the Frame setting screen. Clicking the 
[Cancel] button or  button on the upper right of the screen closes the 
Frame setting screen canceling the current settings. 

 

Figure 3.1.2.2-1  Frame setting screen 
 

The following parameters can be set in the Frame setting screen. 

The Number of Frames 
[Overview] Set the number of frames. 
[Default] 1 
[Setting range] 1 to 32767 
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[Remarks] The number of frames is automatically set when the 
check box  is selected. On the Burst 
parameter setting sheet, the number of frames that 
retain the continuity of the continuous pattern set in 
the Data Field area (refer to Section 3.1.2.4 “Field” for 
details) is automatically set. When the continuous 
pattern is PN9, for example, the number of frames is 
automatically set to 511, retaining the PN9 continuity. 
On the Continuous parameter setting sheet, the 
number of frames that retains the phase continuity as 
well as the continuity of the continuous pattern is 
automatically set. But if the continuous pattern is set 
to “UserFile” when the check box  is selected, 
the number of frames is automatically set to 1 or a 
value that retains the phase continuity only.  
When the check box  is cleared, the number 
of frames can be set freely within the setting range. 
Note, however, the continuity of the continuous 
pattern and phase is not guaranteed in this event. 
 

The Number of Slots per Frame 
[Overview] Set the number of slots per frame. 
[Default] 1 
[Setting range] 1 to 20 
[Remarks] The transmission status can be selected for the slots to 

be used (set by ON/OFF). It is prohibited to set all the 
slots to OFF. In the Continuous parameter setting 
sheet, an ALL1 signal is output for the 
transmission-OFF slots (slots for which the 
transmission status is set to OFF). 
The signal output level when the transmission status 
is OFF is the same as that when the transmission 
status is ON. 

 



 

Chapter 3  Detailed Description of Functions 

3-20 

3.1.2.3 Slot 
The slot format can be set in the “Slot” setting item. This setting item is 
not provided in the No Format parameter setting sheet. The setting 
items for “Slot” in the Burst parameter setting sheet and that in the 
Continuous parameter setting sheet are different. Clicking the [Slot] 
button on the Burst or Continuous parameter setting sheet displays the 
Slot setting screen. 

The slot format set here is commonly applied to all the transmission-ON 
slots. On slot can be divided into up to 24 fields. The number of bits and 
field type (Guard, Ramp, Fixed, Data, or CRC) can be set for each field. 
The fields for which the number of bits is set to 0 are recognized as 
nonexistent. 

When the 2nd modulation type is set in the Burst parameter setting 
sheet, the setting range for the 1st modulation type is between the first 
and 12th fields, and that for the 2nd modulation type is between the 13th 
to 24th fields. 

When the [Apply] button on the screen is clicked after setting the 
parameters, the Slot Format image on the upper of the Frame screen is 
modified according to the settings. Clicking the [OK] button applies the 
current settings and closes the Slot setting screen. Clicking the [Cancel] 
button or  button on the upper right of the screen closes the Slot 
setting screen canceling the current settings. 
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Setting items for Burst 

 

Figure 3.1.2.3-1  Slot setting screen for Burst (When running on PC, 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A) 

 

  

Figure 3.1.2.3-2  Slot setting screen for Burst (When running on 
MG3710A or MG3740A) 



 

Chapter 3  Detailed Description of Functions 

3-22 

The following parameters can be set in the Slot setting screen for Burst. 

Guard 
[Overview] Set the number of bits in the Guard field. 

The Guard field is fixed to the first and 24th fields. 
[Setting range] The setting range for the number of bits is determined 

as follows according to the set modulation type. 
 

Table 3.1.2.3-1  Setting range for Guard 

(1st/2nd) Modulation Type Number of Bits in 1st Field Number of Bits in 24th Field 
BPSK, DBPSK, PI/2DBPSK, 
2ASK, 2FSK Integer number from 0 to 9960 Integer number from 0 to 9960 

QPSK, O-QPSK, DQPSK, 
PI/4DQPSK, 4ASK, 4FSK Multiples of 2 from 0 to 9960 Multiples of 2 from 0 to 9960 

8PSK, D8PSK Multiples of 3 from 0 to 9960 Multiples of 3 from 0 to 9960 
16QAM Multiples of 4 from 0 to 9960 Multiples of 4 from 0 to 9960 
32QAM Multiples of 5 from 0 to 9960 Multiples of 5 from 0 to 9960 
64QAM Multiples of 6 from 0 to 9960 Multiples of 6 from 0 to 9960 
256QAM Multiples of 8 from 0 to 9960 Multiples of 8 from 0 to 9960 

 
Ramp 
[Overview] Set the number of bits in the Ramp field. 

The Ramp field is fixed to the second and 23rd fields. 
The number of bits equivalent to the symbol length set 
in the second field is automatically set to the 23rd 
field. 

[Setting range] The setting range for the number of bits is determined 
as follows according to the set modulation type. 
 

Table 3.1.2.3-2  Setting range for Ramp 

(1st/2nd) Modulation Type Number of Bits 
BPSK, DBPSK, PI/2DBPSK, 
2ASK, 2FSK Integer number from 1 to 16 

QPSK, O-QPSK, DQPSK, 
PI/4DQPSK, 4ASK, 4FSK Multiples of 2 from 2 to 32 

8PSK, D8PSK Multiples of 3 from 3 to 48 
16QAM Multiples of 4 from 4 to 64 
32QAM Multiples of 5 from 5 to 80 
64QAM Multiples of 6 from 6 to 96 
256QAM Multiples of 8 from 8 to 128 
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Slot 
The following items are available:  

Fixed 
[Overview] Set the number of bits in the fixed data field. 

The fixed data field can be set to the 3rd through 22nd 
fields. 

[Setting range] An integer number from 0 to 128 
 

Data 
[Overview] Set the number of bits in the continuous pattern data 

field, such as a pseudo random pattern (PN9, PN15). 
The continuous pattern data field can be set to the 3rd 
through 22nd fields. 

[Setting range] An integer number from 0 to 1024 
 

CRC 
[Overview] Set the number of bits in the cyclic redundancy check 

(CRC) field. 
The CRC field can be set to the 4th through 22nd 
fields. 

[Options] 0, 8, 12, 16, 24, 32 
[Remarks] The following generation polynomial expressions are 

used according to the set number of bits: 
8 bits: x8 + x7 + x4 + x3 + x + 1 
12 bits: x12 + x11 + x3 + x2 + x + 1 
16 bits: x16 + x12 + x5 + 1 
24 bits: x24 + x23 + x6 + x5 + x + 1 
32 bits: x32 + x26 + x23 + x22 + x16 + x12 + x11 + x10 + x8 

+ x7 + x5 + x4 + x2 + x + 1 
 

 The total number of bits in the left fields of the CRC 
field (excluding Guard and Ramp fields) must be 1 or 
more. When setting two or more CRC fields, the total 
number of bits between the CRC field and the previous 
CRC field must be 1 or more. The CRC calculation 
area can be set in the Field setting screen (refer to 
Section 3.1.2.4 “Field” for details). 
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The total number of bits in the Fixed, Data, and CRC fields is restricted 
as follows according to the set modulation type. When the 2nd 
modulation type is set, the total number of bits for the 1st modulation 
type should be calculated from the third to 12th fields, and that for the 
2nd modulation type should be calculated from the 13th to 22nd fields. 
Also, note that the total number of bits cannot be set to 0. 
 

Table 3.1.2.3-3  Restrictions on total number of bits for modulation type 

(1st/2nd) Modulation Type Total Number of Bits 
BPSK, DBPSK, PI/2DBPSK, 2ASK, 
2FSK 

− 

QPSK, O-QPSK, DQPSK,  
PI/4DQPSK, 4ASK, 4FSK 

Multiples of 2 

8PSK, D8PSK Multiples of 3 
16QAM Multiples of 4 
32QAM Multiples of 5 
64QAM Multiples of 6 
256QAM Multiples of 8 

 
2nd Modulation Phase Reference 
[Overview] Set the 0 phase reference symbol. 
 The optional radio buttons are displayed for the third 

to 12th fields when the 2nd modulation type is set. 
When the 1st modulation mode is the differential 
modulation mode, the 2nd modulation is performed 
regarding the phase of the last symbol in the field with 
the selected optional radio button as 0. 
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Setting items for Continuous 

 

Figure 3.1.2.3-3  Slot setting screen for Continuous (When running 
on PC, MS2690A/MS2691A/MS2692A, MS2830A or MS2840A) 

 

 

Figure 3.1.2.3-4  Slot setting screen for Continuous (When running 
on MG3710A or MG3740A) 
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The following parameters can be set in the Slot setting screen for 
Continuous. 

Fixed 
[Overview] Set the number of bits in the fixed data field. 

The fixed data field can be set to the first through 24th 
fields. 

[Setting range] An integer number from 0 to 128 
 

Data 
[Overview] Set the number of bits in the continuous pattern data 

field, such as a pseudo random pattern (PN9, PN15). 
The continuous pattern data field can be set to the 
first through 24th fields. 

[Setting range] An integer number from 0 to 1024 
 

CRC 
[Overview] Set the number of bits in the cyclic redundancy check 

(CRC) field. 
The CRC field can be set to the 2nd through 24th 
fields. 

[Options] 0, 8, 12, 16, 24, 32 
[Remarks] The following generation polynomial expressions are 

used according to the set number of bits: 
8 bits: x8 + x7 + x4 + x3 + x + 1 
12 bits: x12 + x11 + x3 + x2 + x + 1 
16 bits: x16 + x12 + x5 + 1 
24 bits: x24 + x23 + x6 + x5 + x + 1 
32 bits: x32 + x26 + x23 + x22 + x16 + x12 + x11 + x10 + x8 

+ x7 + x5 + x4 + x2 + x + 1 
 

 The total number of bits in the left fields of the CRC 
field must be 1 or more. When setting two or more 
CRC fields, the total number of bits between the CRC 
field and the previous CRC field must be 1 or more. 
The CRC calculation area can be set in the Field 
setting screen (refer to Section 3.1.2.4 “Field” for 
details). 
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The total number of bits is restricted as follows according to the set 
modulation type. Also, note that the total number of bits cannot be set to 
0. 
 

Table 3.1.2.3-4  Restrictions on total number of bits 

Modulation Type Total Number of Bits 
BPSK, DBPSK, PI/2DBPSK, 2ASK, 
2FSK 

− 

QPSK, O-QPSK, DQPSK, PI/4DQPSK, 
4ASK, 4FSK 

Multiples of 2 

8PSK, D8PSK Multiples of 3 
16QAM Multiples of 4 
32QAM Multiples of 5 
64QAM Multiples of 6 
256QAM Multiples of 8 
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3.1.2.4 Field 
In the “Field” setting item, the contents of each field in a 
transmission-ON slot can be set. This setting item is not provided in the 
No Format parameter setting sheet. Clicking the [Field] button on the 
Burst or Continuous parameter setting sheet displays the Field setting 
screen. 

The slot format image is displayed on the upper of the Field setting 
screen, like in the Slot setting screen. Select a slot to be set from the Slot 
Format list box on the upper-left of the screen. The field numbers, field 
types, and the numbers of bits in each field are displayed in the middle of 
the screen. For Fixed fields and CRC fields, a text box is displayed on the 
right. For Data fields, their contents can be set in the Data Field area 
under the slot format image. 
When “ALL” is selected from the Slot Format list box, the field settings 
on the Field screen commonly apply to all transmission slots. 

After setting the parameters, click the [OK] button to apply the current 
settings and close the Field setting screen. Clicking the [Cancel] button 
or  button on the upper right of the screen closes the Field setting 
screen canceling the current settings. 

 

Figure 3.1.2.4-1  Field setting screen (When running on PC, 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A) 
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Figure 3.1.2.4-2  Field setting screen (When running on MG3710A or MG3740A) 
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The following parameters can be set in the Field setting screen. 

Slot Format 
The slot whose transmission setting is set to ON in 3.1.2.2 “Frame” can 
be selected.  

[Overview] Select from the list box a slot whose field is to be set. 
[Default] ALL 
[Setting range] Slots whose transmission status is set to ON in the 

Frame setting screen (transmission-ON slots). 
[Remarks] When “ALL” is selected, the set field contents will be 

applied to all the transmission-ON slots. 
 

Fixed 
[Overview] Set fixed data in the text box in hexadecimal. 
[Default] 1 
[Setting range] 0 to the maximum value within the set number of bits 

(Ex. 0 to 1F when the set number of bits is 5) 
 

CRC 
[Overview] Set a CRC calculation area in the text box by integer 

number. 
[Default] 1 
[Setting range] 1 to the total number of bits in the left fields 

(excluding Guard and Ramp fields) of the CRC field. 
When there are two or more CRC fields, the maximum 
value for the second and subsequent CRC fields is the 
total number of bits between the CRC fields. 

[Remarks] The initial value of the CRC register can be set by 
using the radio buttons in Initial Content of the 
Register in the CRC Field area. All the initial values 
are set to 0 when the ALL0 radio button is selected, 
and are set to 1 when the ALL1 radio button is 
selected. 
The CRC Field area also provides the Ones 
Complement check box. When this check box is 
selected, the 1’s complement of the register value after 
CRC calculation is used for the CRC field. When this 
check box is cleared, the register value after CRC 
calculation is used as is. 
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Data 
[Overview] Select a continuous pattern from the list box in the 

Data Field area. 
When “16-bit Pattern” is selected, the 16-bit Pattern 
(Common) text box on the right in this area becomes 
enabled. Enter an arbitrary “16-bit Pattern” in this 
text box in hexadecimal. It is also possible to load a 
user file for setting. 

[Default] PN9 
[Options] PN9, PN15, 16-bit Pattern, ALL0, ALL1, UserFile 
[Remarks] When two or more Data fields exist in one slot, the 

continuity of the Data fields within the slot is retained. 
However, the continuity of the Data fields between 
different slots should be specified by the radio buttons 
on the right of the list box. When the radio button 
“Data Field has a continuity between the fields in the 
adjacent slots.” is selected, the continuity of the Data 
fields is retained between the transmission-ON slots. 
In this event, if “16-bit Pattern” is selected for the 
continuous pattern, the value entered in the text box is 
commonly applied to all the transmission-ON slots. 
When the radio button “Data Field has a continuity 
between the fields in the same number slots.” is 
selected, the continuity of the Data fields is retained 
between the transmission-ON slots having the same 
number in each frame. In this event, if “16-bit Pattern” 
is selected for the continuous pattern, an individual 
value can be set in the text box for each 
transmission-ON slot (see Figure 3.1.2.4-3). 
When “UserFile” is selected in the Data Field list box, 
a screen for selecting a user file for continuous pattern 
is displayed, enabling to load a user-defined bit string 
other than the provided selection items. Refer to 
Appendix C “User File Format” for details on the user 
file. 
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When “Data Field has a continuity between the fields in the adjacent slots.” is selected 
 

 

When “Data Field has a continuity between the fields in the same number slots.” is selected 
 

Figure 3.1.2.4-3  Continuity of Data field when one frame contains three transmission-ON slots 
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3.1.2.5 Data 
In the “Data” setting item, a continuous pattern such as a pseudo 
random pattern (PN9, PN15) can be set for a No Format waveform 
pattern. This setting item is not provided in the Burst and Continuous 
parameter setting sheets. Clicking the [Data] button on the No Frame 
parameter setting sheet displays the Data setting screen. 

After setting the parameters, click the [OK] button to apply the current 
settings and close the Data setting screen. Clicking the [Cancel] button 
or  button on the upper right of the screen closes the Data setting 
screen canceling the current settings. 

 

Figure 3.1.2.5-1  Data setting screen (When running on PC, 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A) 
 

 

Figure 3.1.2.5-2  Data setting screen  
(When running on MG3710A or MG3740A) 
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The following parameter can be set in the Data setting screen. 

Data 
[Overview] Select a continuous pattern from the Data list box. 

When “16-bit Pattern” is selected, the 16-bit Pattern 
text box under the list box becomes enabled. Enter an 
arbitrary “16-bit Pattern” in this text box in 
hexadecimal. It is also possible to load a user file for 
setting. 

[Default] PN9 
[Options] PN9, PN15, 16-bit Pattern, ALL0, ALL1, UserFile 
[Remarks] When “UserFile” is selected in the Data Field list box, 

a screen for selecting a user file for continuous pattern 
is displayed, enabling to load a user-defined bit string 
other than the provided selection items. Refer to 
Appendix C “User File Format” for details on the user 
file. 
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3.1.2.6 Filter 
The “Filter” setting item is used for setting a filter. Clicking the [Filter] 
button on a parameter setting sheet displays the Filter setting screen. 

After setting the parameters, click the [OK] button to apply the current 
settings and close the Filter setting screen. Clicking the [Cancel] button 
or  button on the upper right of the screen closes the Filter setting 
screen canceling the current settings. 

 

Figure 3.1.2.6-1  Filter setting screen (When running on PC, 
MS2690A/MS2691A/MS2692A, MS2830A or MS2840A) 
 

 

Figure 3.1.2.6-2  Filter setting screen (When running on MG3710A or MG3740A) 
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The following parameters can be set in the Filter setting screen. 

Filter 
[Overview] Set the filter type. 
[Default] RootNyquist 
[Options] Nyquist, RootNyquist, Gaussian, Gaussian2, 

IdealLowpass, None, ARIB STD-T98, Half-sine, ARIB 
STD-T102Part1, User Defined Filter 

[Remarks] IdealLowpass is a rectangular filter.  It is not an ideal 
filter since the number of filter coefficients is limited. 
When the check box  has been selected in the 
Modulation setting screen to enable the GSM setting, 
Specified Filter is displayed and a filter that conforms 
to the GSM specifications is automatically set. 
If 2FSK or 4FSK is specified for Modulation Type on 
the Modulation setting screen, symbols are filtered. 
ARIB STD-T98 and ARIB STD-T102Part1 can only be 
selected if 4FSK is specified for Modulation Type on 
the Modulation setting screen. 
The ARIB STD-T98/T102 filter is specified for the 
four-frequency shift keying of the ARIB STD-T98/T102 
standards and has the configuration shown in the 
following figure. 

   

 

( )fH  ( )fP  

 

Figure 3.1.2.6-3  ARIB STD-T98/102 filter composition 
 

Here, H(f) is the RootNyquist function, and P(f) is the 
sinc function (T98) or Gaussian function (T102). 
Half-sine can only be selected if O-QPSK is specified 
for Modulation Type on the Modulation setting screen. 
The impulse response is expressed as the formula 
below when the filter is set to Gaussian.  
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The impulse response is expressed as the formula 
below when the filter is set to Gaussian2. 
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Here δ is a constant expressed as the formula below.  
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 The following figure shows the comparison of 
amplitude characteristics between the filter types 
(Gaussian and Gaussian2).  
(Horizontal axis: Frequency normalized to the symbol 
rate, BT = 0.5, Over Sampling = 8) 

In comparison with Gaussian2, Gaussian has the 
narrower passband, and its amplitude becomes 0 at an 
integer multiples of the Symbol Rate frequency, due to 
the influence of rect(t/T). 

 

Figure 3.1.2.6-4  Amplitude characteristics of Gaussian and Gaussian2 
filters 

 The user file format when the filter is set to User 
Defined Filter is as below. 
-Each filter coefficient should be separated by return 
key in ASCII format. (Commas, spaces, and tabs are 
taken as errors.) 
-There must be a FIR filter coefficient string expressed 
by time response (as real number). 
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-The filter coefficient tap number must be an odd 
number in the range from 1 to 1023. 

 
Roll Off/BT 
[Overview] Set the roll-off rate for filter (when Nyquist or 

RootNyquist is set) or BT product (when Gaussian is 
set). 

[Default] 1 
[Setting range] 0.10 to 1.00 
[Remarks] This item is displayed and can be set only when 

Nyquist, RootNyquist, or Gaussian is set for the filter 
type. 
 

Passband 
[Overview] Set the passband of filter. 
[Default] Fs/oversampling rate (Fs: Sampling rate) 
[Options] Fs/2, Fs/3, Fs/4, Fs/8, Fs/16, Fs/32 
[Remarks] The setting range varies depending on the 

oversampling rate. 
This item is displayed and can be set only when 
IdealLowpass is set for the filter type. 
 

RMS 
[Overview] Set the RMS value of waveform pattern. 
[Default] 1634 
[Setting range] 651 to 4104 
[Remarks] The RF output level accuracy of the mainframe is 

specified by an RMS value from 1157 to 1634.  
Note: 

When started up in MG3710, MG3740, MS2830 or MS2840 mode, 
the initial value is 1157. RMS value is fixed to 1157 in MS269x 
mode. 
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3.1.2.7 Pattern Name 
The “Pattern Name” setting item is used to set a waveform pattern file 
name. Clicking the [Pattern Name] button on a parameter setting sheet 
displays the Pattern Name setting screen shown in Figure 3.1.2.7-1. 

After setting the parameters, click the [OK] button to apply the current 
settings and close the Pattern Name setting screen. Clicking the [Cancel] 
button or  button on the upper right of the screen closes the Pattern 
Name setting screen canceling the current settings. 

 

Figure 3.1.2.7-1  Pattern Name setting screen 
 

The following parameters can be set in the Field setting screen. 

Package 
[Overview] Enter the name of the package that saves waveform 

patterns to be created. 
[Default] TDMA_IQproducer 
[Setting range] Within 31 characters, including alphanumeric and the 

following symbols: 
! % & ( ) + = ` { } _ - ^ @ [ ] 
 

Pattern Name 
[Overview] Enter a waveform pattern file name. 

One waveform pattern consists of a waveform 
information file with the extension “.wvi” and a 
waveform data file with the extension “.wvd”. These 
file names are the same except for the extension. 

[Default] Initial_Burst/Initial_Continuous/Initial_NoFormat 
[Setting range] Within 20 characters, including alphanumeric and the 

following symbols: 
! % & ( ) + = ` { } _ - ^ @ [ ] 
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Comment 
[Overview] Enter comments to be displayed on the screen. 

The settings of Modulation Type and Over Sampling 
are displayed in the first line, and the settings of Filter 
Type are displayed in the second line. 
When Modulation Type is User defined, “user file 
name” selected at Modulation Mapper and “Over 
Sampling” are displayed in the first line.  
A comment can be entered by a user in the third line 
only. This line can be left blank. 

[Default] Initial_State 
[Setting range] Within 38 characters. 
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3.1.2.8 Re-setting by changing parameter 
Although it is not necessary to perform parameter settings in the order 
indicated by arrows (see Figure 3.1.1-7 “Parameter setting sheets”), some 
parameters have an effect on the subsequent parameters when they are 
set. 

Automatic setting when Modulation Type is changed 
The parameters on the Slot setting screen are automatically changed 
depending on the setting of “Modulation Type” in the Modulation setting 
screen. When “Modulation Type” is changed on the Modulation setting 
screen after setting the parameters on the Slot setting screen, therefore, 
be aware that the parameters on the Slot setting screen will be changed 
automatically. Tables 3.1.2.8-1 and 3.1.2.8-2 show the values 
automatically set after changing “Modulation Type.” 

Table 3.1.2.8-1  Automatically set values (Burst) 

Field No. of Bits Field Type 
1st 0 Guard 

2nd Number of bits per symbol 
for the set modulation type Ramp 

3rd 240 Data 
13th 240 Data 

23rd Number of bits per symbol 
for the set modulation type Ramp 

24th Number of bits per symbol 
for the set modulation type Guard 

Other than the above 0 Fixed 
 

Table 3.1.2.8-2  Automatically set values (Continuous) 

Field No. of Bits Field Type 
1st 240 Data 
Other than the above 0 Fixed 

 
Automatic setting due to change in Frame or Slot setting item 

When the number of transmission-ON slots is increased or a 
transmission-OFF slot is changed to a transmission-ON slot in the 
Frame setting screen, all the values of Fixed and CRC fields in the Field 
setting screen are automatically set to “1” for the slots that are 
set/changed to transmission-ON. 
This automatic setting operation also occurs when the slot format in the 
Slot setting screen is changed. Care must be taken, therefore, when 
changing the parameters on the Frame or Slot setting screen after the 
parameters on the Field setting screen have been set. 
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3.1.3 Calculation 
The “Calculation” button is used to start waveform pattern generation 
after parameter setting is completed. Click the [Calculation] button on a 
parameter setting sheet to display the Export Path screen shown in Fig. 
3.1.3 -1, and select the waveform pattern output destination on this 
screen. 

 
Output destination folder 

selection button 

 

Figure 3.1.3-1  Export Path screen for selecting waveform pattern 
output destination 

 

Clicking the output destination selection button displays the Browse for 
Folder screen shown in Figure 3.1.3-2. The output destination folder can 
be selected from this screen. 

 

Figure 3.1.3-2  Browse for Folder screen 
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The default destination folder for waveform patterns in each instrument 
is shown in the table below. 

Table 3.1.3-1  Default export destination folder  

Instrument Operating 
environment Export destination folder 

MG3700A – 

X:\IQproducer\TD-SCDMA\Data 
(X:\ IQproducer is a folder where IQproducer is 
installed) 
This can be changed. 

MG3710A 
MG3710A 

C:\Anritsu\MG3710A\User Data 
\Waveform\”Package name” 
This cannot be changed. 

PC Same as MG3700A 

MS269xA, 
MS2830A,  
MS2840A 

MS269xA, 
MS2830A,  
MS2840A 

When Installed OS is Windows Embedded Standard 7. 
C:\Anitsu\Signal Analyzer\System\Waveform 
Other than above.  
C:\Program Files\Anritsu Corporation 
\Signal Analyzer\System\Waveform\” Package 
name” 
This cannot be changed. 

PC Same as MG3700A 

 

After the output destination folder is specified, the Waveform Generation 
screen shown in Figure 3.1.3-3 is displayed, but if the waveform pattern 
sample size exceeds the upper limit of the memory, an error screen is 
displayed and the waveform is not generated. However, when the frame 
count is set to Auto at the Frame Parameter setting screen, if the waveform 
pattern sample size exceeds the above-described limit range, the waveform 
pattern is generated by reducing the frame count; when the directions 
indicate a Burst waveform, the frame count becomes 1 to generate a 
waveform. For a Continuous waveform, the waveform is generated with a 
continuous phase, but even in this case, the waveform is generated with a 
frame count of 1 if the sample count exceeds the limit range. Furthermore, 
for a waveform pattern with less than 1000 samples, the frame count is 
increased to generate the waveform as for a waveform pattern with 1000 or 
more samples. Table 3.1.3-1 shows the method for calculating the waveform 
pattern sample count. 
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Figure 3.1.3-3  Waveform generation screen (in progress) 
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Table 3.1.3-2  How to calculate the number of samples of waveform pattern 

 

 
When waveform generation is completed, “Calculation Completed” is 
displayed on the screen as shown in Fig. 3.1.3-4, and the [Cancel] button 
changes to the [OK] button. 
If the amplitude value of the waveform pattern is out of the range from 
−8192 to 8191, clipping is processed and “Clipping was done.” is 
displayed on the screen. Clipping is a process to “clip” the part of the 
amplitude value that exceeds the limitation range. When clipping is 
processed, a waveform may be distorted, resulting in the degradation in 
the adjacent channel leakage power ratio and/or waveform quality. 

 

Figure 3.1.3-4  Waveform generation screen  
(when calculation completed) 

 

When the [Cancel] button is clicked during waveform generation, the 
waveform generating operation is interrupted, the waveform generation 
screen is closed, and the TDMA main screen is displayed again. The 
waveform generating operation is also interrupted if the size of the 
intermediate file that is created during waveform generation exceeds 4 
GB (“Can not read file” is displayed on the screen at this time). In this 
event, reduce the number of frames, for example, to complete the 
waveform generating operation. 

For Burst: Symbol × Slot_ON × Frame × OSR [samples] 
For Continuous: Symbol × Slot × Frame × OSR [samples] 
 where; Symbol: The number of symbols in a slot 

Slot_ON: Number of the last transmission-ON slot in a frame 
Slot: The number of slots in a frame 
Frame: The number of frames 
OSR: Oversampling rate 
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When the [OK] button is clicked after waveform generation is completed, 
the waveform generation screen is closed and the TDMA main screen is 
displayed again. 

 

3.1.4 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A or MG3740A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

Button for selecting load destination 

 

 

Figure 3.1.4-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 3.1.4-2  Select Memory Screen 
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After selecting the load destination of generated waveform in the Select 
Memory screen and clicking the OK button, the Load Setting screen will 
be shown again. Click the OK button in the Load Setting screen, and 
then the loading of waveform starts.  

Note: 
To exit this screen without loading the waveform pattern, click the 
Cancel button in the Load Setting screen.  

 

3.1.5 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A or MG3740A.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.1.5-1  Select SG Screen 
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3.1.6 Saving/reading parameters 
This numeric values and settings for each item can be saved in a 
parameter file by using this software. 

■ Saving parameter file 
When running on PC, MS2690A/MS2691A/MS2692A, MS2830A or MS2840A 

1. Select [Save Parameter File] from the [File] menu or click the   
tool button to display the parameter file saving screen shown. 

 

Figure 3.1.6-1  Parameter file saving screen 
 

2. Enter a file name in the [File name] text box and click the [Save] 
button to save the parameter file. 
When the save destination is not changed in the [Save in] box, the 
parameter file is saved in the following directory with the entered 
file name: 
X:\IQproducer\TDMA\Entered file name.prm 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 
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When running on MG3710A or MG3740A 
1. Click the[Save Parameter File] button in [File] menu or click the 

 button to display the parameter file saving screen.  
 

 

Figure 3.1.6-2  Parameter file saving screen (MG3710A or MG3740A) 
 

2. Select the folder to store the file in the Directories field, and then 
enter the name of the file using the File Name box. Click OK to save the 
parameter file. To initialize the setting in the Directories field, click the 
Default Root button. 
 

■ Reading parameter file 
When running on PC, MS2690A/MS2691A/MS2692A, MS2830A or MS2840A. 

1. Select [Recall Parameter File] from the [File] menu or click the   
tool button to display the parameter file reading screen. 

 

Figure 3.1.6-3  Parameter file reading screen 
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2. Select a parameter file to be read from the file list, and then click 
the [Open] button to read the selected parameter file. 

3. The parameter files for creating the waveform patterns of PDC, PHS, 
and User Defined, in which APSK and multi-valued QAM are 
defined, are stored in the following directories: 

 X:\IQproducer\TDMA\sample_parameter_file\PDC 
X:\IQproducer\TDMA\sample_parameter_file\PHS 
X:\IQproducer\TDMA\sample_parameter_file\UserDefined 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 

 Read a parameter file and generate a waveform to create a 
waveform pattern similar to the standard waveform pattern.  

When running on MG3710A or MG3740A. 
1. Select [Recall Parameter File] from the [File] menu or click the 

 tool button to display the parameter file reading screen.  

 

Figure 3.1.6-4  Parameter file reading screen (MG3710A or MG3740A) 
 

2. Select the directory where the files to be loaded is stored in the 
[Directories] field. Click the desired file from the [File List], and 
click [OK]. To initialize the setting in the [Directories] field, click the 
[Default Root] button.  
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3.1.7 Displaying graph 
The generated waveform pattern can be displayed in a CCDF, FFT, or 
Time Domain graph by using this software. For details of each graph 
display, refer to each one of the following: 

• MG3700A/3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™) 

 4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.13 “Time 
Domain Graph Display” 

• MS2690A/MS2691A/MS2692A and MS2830A/MS2840A Vector 
Signal Generator Operation Manual (IQproducer™) 

 4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.9 “Time 
Domain Graph Display” 

Displaying CCDF graph 
1. Generate a TDMA waveform pattern by executing “Calculation.” 
2. Select [CCDF] from the [Simulation] menu or click the   tool 

button. The CCDF graph screen shown in Figure 3.1.7-1 is displayed 
with the trace of the generated waveform pattern. 

 

Figure 3.1.7-1  CCDF graph screen 
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When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the 
CCDF graph screen, the trace of the waveform pattern newly 
generated can be displayed in either of the following two methods: 

• Displaying the new trace in the same screen with the previous 
traces 

• Deleting the previous traces to display the new trace 
 

 

Note: 
A CCDF graph and an FFT graph cannot be generated at the 
same time. When displaying a CCDF graph while an FFT graph 
is displayed, execute the CCDF graph generation after FFT 
graph generation is completed. 

 
 When displaying a new trace in the same screen with the previous traces: 
1. Set [Add] for [Quick Add Mode] on the lower-left of the CCDF graph 

screen. 
2. Select [CCDF] from the [Simulation] menu or click the   tool 

button. The trace of the waveform pattern newly generated is 
additionally displayed in the CCDF graph screen. 
Up to eight traces can be displayed by repeating this procedure. 
 

 When deleting the previous traces to display a new trace: 
1. Set [Clear] for [Quick Add Mode] on the lower-left of the CCDF 

graph screen. 
2. Select [CCDF] from the [Simulation] menu or click the   tool 

button. The confirmation message shown in Figure 3.1.7-2 below 
appears: 

 

Figure 3.1.7-2  Confirmation message 
 

 Click the [Yes] button. The previous traces are deleted from the 
CCDF graph screen, and the trace of the waveform pattern newly 
generated is displayed. 
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Displaying FFT graph 
1. Generate a TDMA waveform pattern by executing “Calculation.” 
2. Select [FFT] from the [Simulation] menu or click the   tool 

button. The FFT graph screen shown in Figure 3.1.7-3 is displayed 
with the trace of the generated waveform pattern. 

 

Figure 3.1.7-3  FFT graph screen 
 

When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the FFT 
graph screen, the trace of the waveform pattern newly generated can 
be displayed in either of the following two methods: 

• Displaying the new trace in the same screen with the previous 
traces 

• Deleting the previous traces to display the new trace 
 

Note: 
A CCDF graph and an FFT graph cannot be generated at the 
same time. When displaying an FFT graph while a CCDF graph 
is displayed, execute the FFT graph generation after CCDF 
graph generation is completed. 
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 When displaying a new trace in the same screen with the previous traces: 
1. Set [Add] for [Quick Add Mode] on the lower-left of the FFT graph 

screen. 
2. Select [FFT] from the [Simulation] menu or click the  tool 

button. The trace of the waveform pattern newly generated is 
additionally displayed in the FFT graph screen. 
Up to four traces can be displayed by repeating this procedure. 
 

 When deleting the previous traces to display a new trace: 
1. Set [Clear] for [Quick Add Mode] on the lower-left of the FFT graph 

screen. 
2. Select [FFT] from the [Simulation] menu or click the   tool 

button. The confirmation message shown in Figure 3.1.7-4 below 
appears: 

 

Figure 3.1.7-4  Confirmation message 
 

 Click the [Yes] button. The previous traces are deleted from the FFT 
graph screen, and the trace of the waveform pattern newly 
generated is displayed. 

 



 

3.1 Screen Layout and Composition 

3-55 

3 

D
etailed D

escription of Functions 

Displaying the Time Domain graph 
1. Generate a waveform pattern by executing “Calculation”. 
2. When Time Domain is clicked in the Simulation menu or  is 

clicked, the Time Domain graph screen shown in Figure 3.1.7-5 is 
displayed, along with a trace of the generated waveform pattern. 

 

Figure 3.1.7-5  Time Domain graph 
 

 When a waveform pattern is generated by changing parameters and 
executing “Calculation” while other traces are displayed in the Time 
Domain Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed in either of the following two 
methods:  

• Displaying the new trace in the same screen as the previous 
traces 

• Deleting the previous traces to display the new trace 
 

 Note: 
CCDF, FFT, and Time Domain graphs cannot be created 
simultaneously. To display all these graphs, complete creation 
of each graph and then create a separate graph.  
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■ Displaying the new trace in the same screen as the previous traces 
1. Set Add for Quick Add Mode on the lower-left of the Time 

Domain Graph Monitor screen.  
2. When Time Domain is clicked in the Simulation menu or  is 

clicked, a trace of the newly generated waveform pattern is 
added to the Time Domain graph screen. 
Up to four traces can be displayed by repeating this procedure. 

■ When deleting the previous traces to display a new trace: 
1. Set Clear for Quick Add Mode on the lower-left of the Time 

Domain Graph Monitor screen.  
2. When Time Domain is clicked in the Simulation menu or  is 

clicked, a message such as that shown in Figure 3.1.7-6 is 
displayed. 

 

Figure 3.1.7-6  Confirmation screen 

 Click Yes. The previous traces are deleted, and the trace of the 
waveform pattern newly generated is displayed.  
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3.1.8 Auxiliary signal output 
When a waveform pattern generated by the TDMA IQproducerTM is 
selected by the Vector Signal Generator, a marker signal synchronized 
with the RF signal is output from the AUX input/output connector on the 
rear panel as an auxiliary signal. Refer to the Vector Signal Generator 
Operation Manual (Operation) for details on the AUX input/output 
connector. Frame Trigger (Connector 1), RF Gate (Connector 2) and 
Symbol Clock (Connector 3) are output. 

• Frame Trigger 
A pulse synchronized with the symbol at the beginning of the frame is 
output from Connector 1. The signal polarity can be changed by 
changing the polarity of Connector 1. 
 

• RF Gate 
Indicates the RF output burst ON/OFF status of the Vector Signal 
Generator when a burst wave is used as the waveform pattern. 
Correspondence between the burst status and output signal status is 
shown below: 

 Burst ON: High level 
Burst OFF: Low level 
(When Polarity for Marker 2 is set to Positive. When Polarity is set to 
Negative, the above correspondences are reversed.) 

 
• Symbol Clock 

A symbol clock synchronized with the symbol is output from Marker 3. 
The signal polarity can be changed by changing the polarity of Marker 
3. 
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3.2 Waveform Pattern Generation Procedure 
This section provides the waveform pattern generation procedure, taking 
a PHS downlink waveform pattern as an example. 

 R 

4 

SS 

2 

PR 

6 

UW 

16 

CI 

4 

SA 

16 

TCH 

160 

CRC 

16 

R 

4 

G 

12 

 
R: Ramp time for transient response 0H (4 bits) 
SS: Start symbol 2H (2 bits) 
PR: Preamble 19H (6 bits) 
UW: Sync word Uplink line E149H (16 bits) 

 Downlink line 3D4CH (16 bits) 
CI: Channel identification 0H (4 bits) 
SA: SACCH 8000H (16 bits) 
TCH: Information channel PN9 pseudo random pattern 
CRC: Cyclic redundancy check code CRC bit of CI, SA, TCH 
G: Guard time for transient response 000H (12 bits) 

  

Figure 3.2-1  PHS Slot Format 
 

<Procedure> 
1. Click the tab of Burst parameter setting sheet. 
2. Click the [Modulation] button to display the Modulation setting 

screen. 
3. Set “Modulation Type” to PI/4DQPSK and “Symbol Rate” to 192 ksps. 

Then click the [OK] button to close the Modulation setting screen. 
4. Click the [Frame] button to display the Frame setting screen. 
5. Set “The Number of Frames” to 511 and “The Number of Slots per 

Frame” to 8. For the transmission status, set only the 1st Slot to ON. 
Then click the [OK] button to close the Frame setting screen. 

6. Click the [Slot] button to display the Slot setting screen. 
7. Set the parameters so that the slot format becomes as shown in 

Table 3.2-1. Then click the [OK] button to close the Slot setting 
screen. 
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Table 3.2-1  Slot setting values 

Field No. of Bits Field Type 
1st 0 Guard 
2nd 4 Ramp 
3rd 2 Fixed 
4th 6 Fixed 
5th 16 Fixed 
6th 4 Fixed 
7th 16 Fixed 
8th 160 Data 
9th 16 CRC 
23rd 4 Ramp 
24th 12 Guard 
Other than the above 0 Fixed 

 
8. Click the [Field] button to display the Field setting screen. 
9. Set each field as shown in Table 3.2-2. Then click the [OK] button to 

close the Field setting screen. 
 

Table 3.2-2  Field setting values 

Field Field Type Setting Value 
Data Field − PN9 

CRC Field − 
Clear Ones Complement 
check box and select 
ALL1 radio button for 
register initial value. 

1st Ramp − 
2nd Fixed 2 
3rd Fixed 19 
4th Fixed 3D4C 
5th Fixed 0 
6th Fixed 8000 
7th Data − 
8th CRC 180 
9th Ramp − 
10th Guard − 
Other than the above Fixed − 

 

 
 



 

Chapter 3  Detailed Description of Functions 

3-60. 

10. Click the [Filter] button to display the Filter setting screen. 
11. Set Root Nyquist for Filter Type, 0.5 for Roll Off and 1634 for RMS, 

and then click the [OK] button to close the Filter setting screen. 
12. Click the [Pattern Name] button to display the Pattern Name setting 

screen. 
13. Enter an output file name into the Pattern Name text box. Then 

click the [OK] button to close the Pattern Name setting screen. 
14. Click the [Calculation] button to generate the waveform pattern. 
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal HDD/SSD 
• Loading waveform patterns from the HDD/SSD to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 

 

4.1 For MG3700A, MG3710A or MG3740A ....................... 4-2 
4.1.1 Transferring waveform pattern to internal  

HDD .................................................................. 4-2 
4.1.2 Loading to Waveform Memory ......................... 4-4 
4.1.3 Selecting Waveform Pattern ............................. 4-5 

4.2 For MS2690A/MS2691A/MS2692A or MS2830A ......... 4-6 
4.2.1 Transferring waveform pattern to internal  

HDD/SSD ......................................................... 4-6 
4.2.2 Loading to Waveform Memory ......................... 4-6 
4.2.3 Selecting Waveform Pattern ............................. 4-7 
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4.1 For MG3700A, MG3710A or MG3740A 
This section describes how to download a waveform pattern created for 
the MG3700A/MG3710A/MG3740A to the hard disk of the 
MG3700A/MG3710A/MG3740A and output the pattern.  

4.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

Note: 
This operation is not necessary if you are using MG3710A or 
MG3740A and have generated waveform patterns on MG3710A, 
MG3740A. 

For MG3700A 
• LAN 
• CompactFlash Card 
 
For MG3710A or MG3740A 
• LAN 
• External device such as USB Memory 
 
■ Transferring from PC via LAN (MG3700A, MG3710A, MG3740A) 
Two IQproducerTM tools can be used to transfer a waveform pattern to 
the MG3700A/MG3710A/MG3740A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducerTM after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3700A/MG3710A/MG3740A, loading the waveform from the hard 
disk to the waveform memory, and then outputting the waveform 
pattern can be done using this wizard.  
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• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual IQproducer™.  
Specify the folder that contains the waveform pattern to transfer to 
the MG3700A/MG3710A/MG3740A in the PC-side tree of Transfer & 
Setting Panel. 
 

■ Transferring using a CF card (MG3700A) 
Copy the waveform pattern (***.wvi and ***.wvd files) to be downloaded 
to the MG3700A to the root directory of a CF card.  

Insert the CF card into the card slot on the front panel of the MG3700A, 
and then copy the file to the hard disk. For details about how to use a CF 
card to transfer a waveform pattern, refer to (1) Loading waveform file in 
memory in Section 3.5.2 of the MG3700A Vector Signal Generator 
Operation Manual (Mainframe). 

■ Transferring via external device such as USB memory (MG3710A, 
MG3740A) 

For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A/MG3740A, refer to Section 
7.3.6 “Copying external waveform pattern: Copy” in the MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(Mainframe).  
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4.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern,  it is necessary 
to load the waveform pattern that was transferred to the internal hard 
disk of the MG3700A/MG3710A/MG3740A (described in Section 4.1.1 
“Transferring waveform pattern to internal hard disk”) to the waveform 
memory. A waveform pattern can be loaded into the waveform memory in 
the following two ways. 

■ Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3700A/MG3710A/MG3740A or by using a 
remote command.  

For operation using the front panel, refer below: 

• Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A 
Vector Signal Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal 
Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
■ Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 
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4.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the MG3700A/MG3710A 
according to Section 4.1.2 “Loading to waveform memory”. A waveform 
pattern can be selected in the following two ways. 

■ Configuring using the MG3700A/MG3710A/MG3740A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 3.5.2 (4) “Outputting pattern loaded in Memory A for 
modulation in Edit mode” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 

■ Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducer™). 
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4.2 For MS2690A/MS2691A/MS2692A, MS2830A or 
MS2840A 

This section describes how to download a waveform pattern created for 
the MS2690A/MS2691A/MS2692A, MS2830A or MS2840A to the 
HDD/SSD of the MS2690A/MS2691A/MS2692A, MS2830A or MS2840A 
and output the pattern.  

4.2.1 Transferring waveform pattern to internal HDD/SSD 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MS2690A/MS2691A/MS2692A, MS2830A 
or MS2840A, refer below: 

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.4 “Copying waveform file(s) to HDD/SSD” in the 
MS2830A/MS2840A Signal Analyzer Vector Signal Generator 
Operation Manual (Operation) 

 
Note:  

Transferring waveform patterns is not required if the patterns are 
created using this software. 

4.2.2 Loading to Waveform Memory 
In order to output a modulated signal using the waveform pattern, it is 
necessary to load the waveform patterns stored in the internal HDD/SSD 
to the waveform memory.  

■ Loading to Waveform Memory 
Waveform patterns can be loaded to waveform memories by operating the 
panel or by using a remote command.  

For operation using the front panel, refer below: 

• Section 2.4.1 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.1 “Loading waveform pattern(s) to memory” in the 
MS2830A/MS2840A Signal Analyzer Vector Signal Generator 
Operation Manual (Operation) 
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For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 

• MS2830A/MS2840A Signal Analyzer Vector Signal Generator 
Operation Manual (Remote Control) 
 

4.2.3 Selecting Waveform Pattern 
Select waveform patterns to be used for modulation from those loaded in 
the waveform memory as described in Section 4.2.1 “Transferring 
waveform pattern to internal HDD/SSD” above. 

■ Selecting waveform pattern 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.   

For operation using the front panel, refer below: 

• Section 2.4.2 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

• Section 2.4.2 “Loading waveform pattern(s) to memory” in the 
MS2830A/MS2840A Signal Analyzer Vector Signal Generator 
Operation Manual (Operation) 
 

For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 

• MS2830A/MS2840A Signal Analyzer Vector Signal Generator 
Operation Manual (Remote Control) 
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A list of error messages is shown below. In an error message, n1 and n2 
indicate a numeric value, and s indicates a character string. 

Table A-1  Error messages 

Error Message Description 

Can not open file The file cannot be opened. 
Can not open file (“s”) The file s cannot be opened. 
Can not read file Reading from the file is disabled. 
Can not write file Writing to the file is disabled. 
Directory not found (“s”) The folder s cannot be found. 

Disk full (“s”) The disk capacity becomes full while creating the 
file s. 

Inadequacy: All Off The statuses of all slots are OFF. 
Inadequacy: Blank The setting is left blank. 
Inadequacy: CRC The CRC setting is invalid. 
Inadequacy: Invalid Value The set numeric value is invalid. 
Inadequacy: No Pattern Name A pattern name is not entered. 
Invalid file format The file format is invalid. 
Invalid file format (“s”) The format of the file s is invalid. 

Out of range: s (n1  n2) 
The value of the parameter s is out of the setting 
range from n1 to n2. 

Out of range: The number of samples is over 
256/512Msamples. 

The number of samples of the waveform pattern 
to be generated exceeds 256/512 Msamples. 
Note: 

This message is available only when MG3700 is 
selected in the Select instrument screen at 
startup. 

Out of range: The number of samples is over 
64/128/256/512Msamples. 

The number of samples of the waveform pattern 
to be generated exceeds 64/128/256/512 
Msamples. 
Note: 

This message is available only when MG3710, 
MG3740 is selected in the Select instrument 
screen at startup. 

Out of range: The number of samples is over 
256Msamples. 

The number of samples of the waveform pattern 
to be generated exceeds 256 Msamples. 
Note: 

This message is available only when MS269x, 
MS2830, MS2840 is selected in the Select 
instrument screen at startup. 
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Table A-1  Error messages (Cont’d) 

Error Message Description 

Out of Range:Sampling Rate (kHz) (20-8000) The sampling rate is out of the range of 20 to 
8000 kHz. 

Out of Range:Sampling Rate (MHz) (0.02-8) The sampling rate is out of the range of 0.02 to 8 
MHz. 

The Waveform data file is not generated. The waveform pattern data file is not generated. 
There is no Fixed/Data/CRC field. There are no Fixed/Data/CRC fields in the slot. 

Total bit isn't a multiple of n1. 
The total number of bits in the slot is not a 
multiple of n1. 

Total bit of the first half of the slot isn’t a 
multiple of n1. 

The total number of bits in the first half of the 
slot is not a multiple of n1. 

Total bit of the second half of the slot isn’t a 
multiple of n1. 

The total number of bits in the second half of the 
slot is not a multiple of n1. 

Inadequacy:Maximum frequency deviation isn’t a 
multiple of 3. 

Maximum frequency deviation is not a multiple of 
3.  

Out of range : The number of FIR taps(1 – 1023) The number of filter coefficient taps is out of the 
setting range from 1 to 1023. 

Inadequacy : The number of FIR taps is not odd 
numbers 

The number of filter coefficient taps is not an odd 
number. 

 

A list of warning messages is shown below. 

Table A-2  Warning messages 

Warning Message Description 

All slots shall be the same content of fields. The field settings will apply to all transmission 
slots. 

Change the number of frames to 1? Do you want to change the number of frames to 
1? 

Clipping was done. Clipping has been executed. 
Decrease the number of frames to keep only 
phase continuous? 

Do you want to decrease the number of frames to 
keep only phases continuous? 

Keep phase continuous? Do you want to keep phases continuous? 
There is a possibility that phase is not 
continuous. Phase may not be continuous.  
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Table B.1-1  BPSK 

Allocation Symbol Data 
0 0 
1 1 
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Table B.1-2  BPSK (Rotated 45° counterclockwise) 

Allocation Symbol Data 
0 0 
1 1 
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Table B.2-1  DBPSK 

Differential Symbol Data 
PI 0 
0 1 
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B.3 PI/2DBPSK 
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Table B.3-1  PI/2DBPSK 

Differential Symbol Data 
PI/2 0 
−PI/2 1 
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Q
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Table B.4-1  QPSK 

Allocation Symbol Data 
0 11 
1 01 
2 00 
3 10 
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Q
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2 3

 
 

Table B.4-2  QPSK (Rotated 45° counterclockwise) 

Allocation Symbol Data 
0 11 
1 01 
2 00 
3 10 

 

 



 

B.5 O-QPSK 

B-7 

A
ppendix 

A
ppendix B

 
 

B.5 O-QPSK 

 

Table B.5-1  QPSK 

Allocation Symbol Data 
0 11 
1 01 
2 00 
3 10 
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B.6 DQPSK 
Q

I

PI/2

2PI/2

0

3PI/2

 
 

Table B.6-1  DQPSK 

Differential Symbol Data 
PI/2 00 
2PI/2 01 
3PI/2 10 
0 11 
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B.7 PI/4DQPSK 
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3PI/4 −PI/4 

−3PI/4 

 
 

Table B.7-1  PI/4DQPSK 

Differential Symbol Data 
PI/4 00 
3PI/4 01 
−3PI/4 10 
−PI/4 11 
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B.8 8PSK 
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Table B.8-1  8PSK 

Allocation Symbol Data Allocation Symbol Data 
0 111 4 001 
1 110 5 000 
2 010 6 100 
3 011 7 101 

 
Table B.8-2  8PSK (GSM) 

Allocation Symbol Data Allocation Symbol Data 
0 111 4 001 
1 011 5 101 
2 010 6 100 
3 000 7 110 
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B.9 D8PSK 
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PI/4 

2PI/4 
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3PI/4 

−3PI/4 

−2PI/4 

−PI/4 

0 

 
 

Table B.9-1  D8PSK 

Differential Symbol Data Differential Symbol Data 
PI/4 110 −3PI/4 000 
2PI/4 010 −2PI/4 100 
3PI/4 011 −PI/4 101 
4PI/4 001 0 111 
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B.10 16QAM 
Q

I

0 1 32

4 5 6 7

8 9 1110

12 13 1514

 
 

Table B.10-1  16QAM 

Allocation Symbol 
Data Allocation Symbol 

Data Allocation Symbol 
Data Allocation Symbol 

Data 
0 0111 4 0110 8 0010 12 0011 
1 0101 5 0100 9 0000 13 0001 
2 1101 6 1100 10 1000 14 1001 
3 1111 7 1110 11 1010 15 1011 
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B.11 32QAM 
Q
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Table B.11-1  32QAM 

Allocation Symbol 
Data Allocation Symbol 

Data Allocation Symbol 
Data Allocation Symbol 

Data 
0 11101 8 00100 16 00110 24 01001 
1 01010 9 10111 17 10011 25 11001 
2 11010 10 01110 18 00000 26 01100 
3 01101 11 11011 19 10000 27 11111 
4 00111 12 01000 20 00011 28 10101 
5 10100 13 11000 21 10110 29 00010 
6 00001 14 01011 22 01111 30 10010 
7 10001 15 11110 23 11100 31 00101 

 
 



 

Appendix B  Symbol Points for Each Modulation Type 

B-14 

B.12 64QAM 
Q

I

10 2 3 54 76

98 10 11 1312 1514

1716 18 19 2120 2322
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3332 34 35 3736 3938

4140 42 43 4544 4746

4948 50 51 5352 5554

5756 58 59 6160 6362
 

 

Table B.12-1  64QAM 

Allocation Symbol 
Data Allocation Symbol 

Data Allocation Symbol 
Data Allocation Symbol 

Data 
0 100010 16 100111 32 110111 48 110010 
1 100000 17 100101 33 110101 49 110000 
2 101000 18 101101 34 111101 50 111000 
3 101010 19 101111 35 111111 51 111010 
4 001000 20 001101 36 011101 52 011000 
5 001010 21 001111 37 011111 53 011010 
6 000010 22 000111 38 010111 54 010010 
7 000000 23 000101 39 010101 55 010000 
8 100011 24 100110 40 110110 56 110011 
9 100001 25 100100 41 110100 57 110001 
10 101001 26 101100 42 111100 58 111001 
11 101011 27 101110 43 111110 59 111011 
12 001001 28 001100 44 011100 60 011001 
13 001011 29 001110 45 011110 61 011011 
14 000011 30 000110 46 010110 62 010011 
15 000001 31 000100 47 010100 63 010001 
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B.13 256QAM 
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Table B.13-1  256QAM 
Allocation Symbol Data Allocation Symbol Data Allocation Symbol Data Allocation Symbol Data 
0 10001000 30 00000011 60 00001100 90 00111100 
1 10001010 31 00000001 61 00001110 91 00111110 
2 10000010 32 10001101 62 00000110 92 00011100 
3 10000000 33 10001111 63 00000100 93 00011110 
4 10100010 34 10000111 64 10011101 94 00010110 
5 10100000 35 10000101 65 10011111 95 00010100 
6 10101000 36 10100111 66 10010111 96 10011000 
7 10101010 37 10100101 67 10010101 97 10011010 
8 00100010 38 10101101 68 10110111 98 10010010 
9 00100000 39 10101111 69 10110101 99 10010000 
10 00101000 40 00100111 70 10111101 100 10110010 
11 00101010 41 00100101 71 10111111 101 10110000 
12 00001000 42 00101101 72 00110111 102 10111000 
13 00001010 43 00101111 73 00110101 103 10111010 
14 00000010 44 00001101 74 00111101 104 00110010 
15 00000000 45 00001111 75 00111111 105 00110000 
16 10001001 46 00000111 76 00011101 106 00111000 
17 10001011 47 00000101 77 00011111 107 00111010 
18 10000011 48 10001100 78 00010111 108 00011000 
19 10000001 49 10001110 79 00010101 109 00011010 
20 10100011 50 10000110 80 10011100 110 00010010 
21 10100001 51 10000100 81 10011110 111 00010000 
22 10101001 52 10100110 82 10010110 112 10011001 
23 10101011 53 10100100 83 10010100 113 10011011 
24 00100011 54 10101100 84 10110110 114 10010011 
25 00100001 55 10101110 85 10110100 115 10010001 
26 00101001 56 00100110 86 10111100 116 10110011 
27 00101011 57 00100100 87 10111110 117 10110001 
28 00001001 58 00101100 88 00110110 118 10111001 
29 00001011 59 00101110 89 00110100 119 10111011 
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Table B.13-1  256QAM (Cont’d) 
Allocation Symbol Data Allocation Symbol Data Allocation Symbol Data Allocation Symbol Data 
120 00110011 154 01111100 188 01011001 222 01000011 
121 00110001 155 01111110 189 01011011 223 01000001 
122 00111001 156 01011100 190 01010011 224 11001101 
123 00111011 157 01011110 191 01010001 225 11001111 
124 00011001 158 01010110 192 11001000 226 11000111 
125 00011011 159 01010100 193 11001010 227 11000101 
126 00010011 160 11011000 194 11000010 228 11100111 
127 00010001 161 11011010 195 11000000 229 11100101 
128 11011101 162 11010010 196 11100010 230 11101101 
129 11011111 163 11010000 197 11100000 231 11101111 
130 11010111 164 11110010 198 11101000 232 01100111 
131 11010101 165 11110000 199 11101010 233 01100101 
132 11110111 166 11111000 200 01100010 234 01101101 
133 11110101 167 11111010 201 01100000 235 01101111 
134 11111101 168 01110010 202 01101000 236 01001101 
135 11111111 169 01110000 203 01101010 237 01001111 
136 01110111 170 01111000 204 01001000 238 01000111 
137 01110101 171 01111010 205 01001010 239 01000101 
138 01111101 172 01011000 206 01000010 240 11001100 
139 01111111 173 01011010 207 01000000 241 11001110 
140 01011101 174 01010010 208 11001001 242 11000110 
141 01011111 175 01010000 209 11001011 243 11000100 
142 01010111 176 11011001 210 11000011 244 11100110 
143 01010101 177 11011011 211 11000001 245 11100100 
144 11011100 178 11010011 212 11100011 246 11101100 
145 11011110 179 11010001 213 11100001 247 11101110 
146 11010110 180 11110011 214 11101001 248 01100110 
147 11010100 181 11110001 215 11101011 249 01100100 
148 11110110 182 11111001 216 01100011 250 01101100 
149 11110100 183 11111011 217 01100001 251 01101110 
150 11111100 184 01110011 218 01101001 252 01001100 
151 11111110 185 01110001 219 01101011 253 01001110 
152 01110110 186 01111001 220 01001001 254 01000110 
153 01110100 187 01111011 221 01001011 255 01000100 
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B.14 2ASK 
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Table B.14-1  2ASK 

Allocation Symbol Data 
0 0 
1 1 
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B.15 4ASK 

 
 

Table B.15-1  4ASK 

Allocation Symbol Data 
0 00 
1 01 
2 11 
3 10 

 

Q 

I 0 3 1 2 



 

B.16 2FSK 
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B.16 2FSK 

 
 

Table B.16-1  FSK 

Direction Symbol Data 
+ 1 
− 0 
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B.17 4FSK 

 

Table B.17-1  4FSK (Maximum frequency deviation = 945 Hz) 

Direction Symbol Data Deviation 
+3 01 945 
+1 00 315 
–1 10 –315 
–3 11 –945 

Deviation is calculated by the following:  
 

3
deviationfrequencyMaximumDirectionDeviation ×=
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C.1 IQ Mapping User File Format 
Write binary numbers corresponding to symbol points shown in the 
figures in Appendix B in the order of numbers assigned for symbol points 
using text character 0 or 1 in one line per point. For D8PSK, write binary 
numbers corresponding to phase difference in the order of PI/4, 2PI/4, 
3PI/4, 4PI/4, –3PI/4, –2PI/4, –PI/4 and 0 in one line per point. 

Any extension can be used as long as the user file is a text file. A loading 
error occurs with a file in an invalid format. Shortage in binary numbers 
required for the modulation type or duplication of the same binary 
numbers also result in an error at loading.  

1111 
1110 
1101 
1100 
1011 
1010 
1001 
1000 
0111 
0110 
0101 
0100 
0011 
0010 
0001 
0000 

Figure C.1-1  Example of 16QAM IQ mapping user file 
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When the user file shown in Fig. C.1-1 is loaded, symbol point allocation 
is as shown in Fig. C.1-2. 

Q

I

0 1 32

4 5 6 7

8 9 1110

12 13 1514

 

 Symbol 
Data  Symbol 

Data  Symbol 
Data  Symbol 

Data 
0 1111 4 1011 8 0111 12 0011 
1 1110 5 1010 9 0110 13 0010 
2 1101 6 1001 10 0101 14 0001 
3 1100 7 1000 11 0100 15 0000 

 
Figure C.1-2  16QAM IQ mapping and symbol data table 

when the user file shown in Fig. C.1-1 is loaded 
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C.2 Continuous Pattern User File Format 
Describe binary sequences before modulation. Only 0, 1 and line feed 
characters can be used and any comma or space causes loading error. Up 
to 9600000 bits can be loaded. 

Example: PN9 

11111111100000111101111100010111001100100000100101001110110100011110011111001101 
10001010100100011100011011010101110001001100010001000000001000010001100001001110 
01010101100001101111010011011100100010100001010110100111111011001001001011011111 
10010011010100110011000000011000110010100011010010111111101000101100011101011001 
01100111100011111011101000001101011011011101100000101101011111010101010000001010 
01010111100101110111000000111001110100100111101011101010001001000011001110000101 
1110110110011010000111011110000 

 
The binary sequences are inserted into Data Field one by one starting 
from the top left. Refer to Fig. 5.1.2.4-3 in Section 5 for the continuity of 
Data Field for each Slot. When the total number of bits in the Data Field 
exceeds the number of binary number bits in the user file, the rest are 
inserted from the top of the user file again, as shown in Fig. C.2-1.  
When the checkbox  is selected for the Number of Frames in the 
Frame setting screen and the continuous pattern is set to “UserFile” in 
the Data Field area of the Field setting screen, the number of frames is 
automatically set to 1 or a value that retains the phase continuity only. 

 

Figure C.2-1  Insertion method to Data Field  
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C.3 User Defined Modulation User File Format 
Describe the user file for user defined modulation as follows:  
First row:  

Bit length that configures 1 symbol for user defined modulation  
Second and subsequent rows:  

IQ data used for user defined modulation separated by commas 
The total IQ data must be matched with the value in which 2 is raised to 
the bit length that configures 1 symbol.  

The bit strings corresponding to the IQ data for mapping can be inserted 
optionally. Insert the bit string after the IQ data, separated by a comma. 
When the bit strings are not inserted, the bit strings are automatically 
inserted in zero-based ascending order.  

4 
0.707106781,0.707106781,0000 
0.707106781,-0.707106781,0001 
-0.707106781,0.707106781,0010 
-0.707106781,-0.707106781,0011 
0.965925826,0.258819045,0100 
0.965925826,-0.258819045,0101 
-0.965925826,0.258819045,0110 
-0.965925826,-0.258819045,0111 
0.258819045,0.965925826,1000 
0.258819045,-0.965925826,1001 
-0.258819045,0.965925826,1010 
-0.258819045,-0.965925826,1011 
0.224478343,0.224478343,1100 
0.224478343,-0.224478343,1101 
-0.224478343,0.224478343,1110 
-0.224478343,-0.224478343,1111 

 
Figure C.3-1  Example of user defined modulation mapping user file 

(16APSK)  
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Figure C.3-2  Image of 16APSK IQ mapping when the user file shown 
in Fig. C.3-1 is loaded 

 

Note: 
Any extension can be used when using a text file as the user file. 
When an invalid format is used in the user file, a read error occurs. 

The range of value that can be set to the bit length that configures 
1 symbol is 1 to 11, and the range of total IQ data is 2 to 2048.  
When the values are out of range, a read error occurs.  

When the total IQ data is not matched with a value in which 2 is 
raised to the bit length that configures 1 symbol, a read error 
occurs.  

When there is character other than numerical value, comma, and 
line feed character in the user file, a read error occurs.  

When the user file in which RMS of IQ data is 0 is loaded, an error 
occurs.  

Insert the bit strings to all IQ data. When the bit strings are 
inserted into part of IQ data, a read error occurs. Also, when the 
contents of bit strings are overlapped in the user file, a read error 
occurs.  
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